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Harmony 22.0.4 Release Notes
Harmony 22.0.4, build 22948 (2024-06-19)

Improvements

Import / Export

Multiple frames can now be exported when using the Export Layout Image command (File > Export > Layout Image). The 
new option is called Frames to Export and has the following choices available:

 l Current Frame

 l All Marked Frames

 l All Drawing Key Frames

 l All Frames

WebCC

WebCC's debug mode can now be enabled using the -debug option from either the command prompt or the Service 
Launcher.

The following command can be used to enable all debugging traces:
node app.js -debug <other args>

Which is equivalent of using:
DEBUG=webcc:* node app.js <args>

Specific traces can be enabled using:
node app.js -debug webcc:producer:* <other args>

Which is equivalent to using:
DEBUG=webcc:producer:* node app.js <args>

Scripting

 l The SyncLayer class has been added to the scripting api with the following functions:

 l syncLayers

 l unsyncLayer

 l The ColorOverride class has been extended to include the following functions:

 l setOverrideColorId

 l getOverrideColorId

 l setOverrideColorName

 l getOverrideColorName
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 l addSelectedColor

 l removeSelectedColor

 l setSelectedColorID

 l getSelectedColorID

 l setTraverseMatte

 l getTraverseMatte

 l setSelectedColorMode

 l getSelectedColorMode

 l fromXML

 l toXML

 l The default options for the Python Copy and Paste functions  have been adjusted for clarity and ease of use:

 l harmony.CopyOptions(): The default range is now the current frame length, instead of 0 to 0.

 l harmony.PasteOptions(): The default range is now the current frame length, instead of 0 to 0.

 l harmony.CopyOptions(): Extended with a similar start_frame_src and num_frame_src that 
PasteOptions uses

 l Clipboard.copy should provide an overload of type: copy (const QStringList &nodePaths, const 
OMC::CopyOptions *copyOptions=null) that uses the startFrame and numFrames from the copyOptions.

 l When a range is provided as both method arguments and copyOptions arguments, the method 
arguments overrides it and takes priority

 l If a non CopyOptions or PasteOptions object type is used when that type is expected as an argument, 
an error is now returned.

 l Added OpenH264 as a supported codec when using exporter.exportToQuicktime().

 l The location of external scripting packages can now be set using the TB_EXTERNAL_SCRIPT_PACKAGES_
FOLDER system environment variable.

Linux

 l Harmony is now supported under CentOS Stream 9. The following libraries may need to be installed depending on 
the installation type that was performed:

$ sudo dnf install chkconfig SDL xcb-util-keysyms xcb-util-renderutil xcb-util-image 
xcb-util-wm jbigkit-libs.x86_64

Fixes

The following issues are fixed in this release of Harmony and later.
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General

 l Hitting tab to go from one attribute to another in a node's properties window does not work.  HAR-9627

 l Scrolling the Timeline in macOS with a Magic Mouse or a trackpad causes the view to jump slightly.  HAR-9283

 l Semi transparent 2D layers mixed with 3d layers cause display issues in OpenGL.  SB-5550

 l OpenGL layering is incorrect when using a 2D Composite with 3d elements.  HAR-9636

 l Installing Harmony does not work on Windows 11 when Smart App Control is enabled.  HAR-9642

 l When a shortcuts.conf file is used to specify the location of the USA_DB folder, changing the selected preference 
set in the Preferences windows has no effect.  HAR-9536

 l Harmony may crash when opening a Top or Side view.   HAR-9522

Drawing

 l Deselecting using the Select tool by holding Shift+Alt crashes when used over unselected grouped strokes.  HAR-
9903

 l There is a small delay when using the drawing tools with a mouse.  HAR-9999

 l Slow paste operation due to large numbers of elements and palettes.  HAR-9810

 l Drawings may contain unused pencil textures.  HAR-9594

 l When Snap to Contour is enabled, the Contour Editor will add extra points to the selected drawing.  HAR-9611

 l Selecting “Create Color Art from Line Art” twice causes pencil lines to be copied to the color art.  HAR-9553

 l The soft eraser doesn’t work correctly if the mouse is released while outside the stroke that is being erased.  HAR-
9541

 l The Colour Picker does not pick colours from the correct cursor location when using multiple monitors on Linux.  
HAR-9533

Animation

 l Onion skins are not displayed correctly when "Enable passthrough for all effects" is enabled.  HAR-9583

Import / Export

 l PSD files cannot be imported as Individual Layers if Transparency Type is set to Straight.  HAR-9314

 l PSB (Photoshop Big) files cannot be imported as individual layers.  HAR-6661

Deformers

 l Manipulation of deformers is very slow when the scene camera is not set to the default camera.  HAR-9588
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Library

 l Scene scripts are not saved when creating Templates in Database Mode and configured using a shortcuts.conf file.  
HAR-9603

 l Harmony may Crash when pasting into the Library after undoing a paste operation in the Node View  HAR-9475

Rendering

 l The Scale-Output node always uses the Custom Resolution setting, even when the Resolution Name is defined.  
HAR-9610

 l Batch rendering may be incorrect and inconsistent if a non-existent port is being referenced on the Transformation 
Gate node.  HAR-9478

 l Colour recovery during rendering may lead to incorrect colours in drawings.  HAR-9574

WebCC

 l WebCC fails when exporting a large number of scenes.   HAR-9555

 l A scene exported offline via WebCC creates a palette that references “dummy” textures  HAR-9505

 l WebCC cannot import packages that have a large number of scenes.   HAR-9477

 l When the OS is set to French or Japanese, running the WebCC script produces an error: TypeError [ERR_INVALID_
CHAR]: Invalid character in header content.    HAR-8151

Scripting

 l Javascript binding for QByteArray assumes Latin, and not UTF8.  HAR-9575

 l Process.execute() does not work properly on Windows because stdout is incorrectly named.  HAR-9539

 l Harmony may crash when printing PySide6 objects in Python.  HAR-9479

 l Swapping artwork between art layers does not work through scripting.  HAR-9460

Linux

 l Navigating the Xsheet with keyboard shortcuts with a multi-monitor setup is slower in Harmony 22 than in 
previous versions on Linux.  HAR-9528

 l Harmony crashes if the HOME environment variable is not defined in Linux.  HAR-9623

 l When holding arrow keys to move a drawing in the drawing view, the drawing is not moved continuously on Linux.   
HAR-9609

 l Focus on Mouse Enter stops working each time a new scene is opened on Linux.  HAR-9551

 l Some drawings are skipped when navigating the Drawing Desk using the F and G keyboard shortcuts on Linux.  
HAR-9550

 l The font size is too small when the screen display is scaled on Linux.   HAR-9408
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Harmony 22.0.3 Release Notes
Harmony 22.0.3, build 21960 (2023-09-13)

Fixes

The following issues are fixed in this release of Harmony and later.

General

 l Copy-pasting keyframes from the Timeline may paste the wrong value when ease functions are used. HAR-9374

 l Repeatedly using the Previous Drawing [F] or Next Drawing [G] shortcuts may skip frames on Windows and Linux. 
HAR-9411

 l Pressing and holding the Previous Frame [,] or Next Frame [.] shortcuts skips frames on Linux. HAR-9410

 l Harmony may be unable to read drawings created over 10 years ago. HAR-9358

 l Typing Korean double consonant characters does not work on Windows and Linux. HAR-9080

Timeline

 l Frame Markers disappear when dragging and dropping frames in the Timeline. HAR-9448

Drawing

 l Harmony may crash when using the Create Colour Art from Line Art command on drawings that have invalid 
triangles. HAR-9461

Camera

 l The wrong colour is picked when using the Colour Picker view dropper to pick a colour from the screen, if multiple 
screens are connected and using a scaling factor other than 100%. HAR-9198

Effects and Compositing

 l Highlight and Tone effects don’t render properly when Use Matte Colour and Invert Matte options are enabled. 
HAR-9277

 l Particles have the wrong size when the scene’s FOV is not set to vertical. HAR-9325

 l Harmony may crash when rendering gaussian blurs if the Repeat Edge Pixels attribute is enabled. HAR-9304

 l Radio buttons in the Write node Enabling tab all have the same label. HAR-9383

Scripting

 l DrawingTools.modifyStrokes from the extended scripting interface cannot be used to change the thickness of a 
pencil stroke. HAR-9269
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Import / Export

 l There is no audio in exported movies when Harmony is in Spanish. HAR-9360

 l Harmony may run out of memory when rendering if there's an Animate Pencil Texture effect node in a scene that 
has over 1200 frames. HAR-9363

 l Animate Pencil Texture effect is randomly not applied when there are two drawing nodes or more. HAR-9364

 l The last exposed drawing is rendered on empty frames when exporting using the File > Export > OpenGL Frames… 
command. HAR-9121

WebCC

 l A scene exported before upgrading to 22.0.2 cannot be imported using WebCC after updating the database with 
the new export.dict file. HAR-9367

Control Center

 l Palettes are imported when unchecking the Palettes options if Scene and Backup are not unchecked as well. HAR-
5105

Known Issues
 l When there’s not enough space to display all buttons in a toolbar, the extension that is opened to access the 

buttons will be hidden under views that use OpenGL.  HAR-8186

 l When using Harmony on macOS Big Sur, Harmony may crash when saving a colour in macOS’s native colour 
picker. HAR-8032

 l Database scenes that have a custom path cannot be copied using Control Center. HAR-6386

 l Stroke remains in place after removing the last point of a branch with the centreline editor. HAR-5994

 l When using an iPad Pro in Sidecar mode with Harmony, every second click registers as a double-click.  HAR-8801

 l Updating the operating system to macOS Ventura may help fix this issue.

 l On macOS Mojave, GateKeeper prevents launching Harmony unless the quarantine extended attribute is removed 
from the application bundle. HAR-7775

The quarantine extended attribute can be removed using the following command in the Terminal:

$ sudo xattr -dr com.apple.quarantine "/Applications/Toon Boom Harmony 22 Premium"
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Harmony 22.0.2 Release Notes
Harmony 22.0.2, build 21617 (2023-06-12)

Improvements

Utilities

 l The utransform utility now has the ability to print and clear metadata from a TVG using the -print_meta_data and -
clear_meta_data options. HAR-8421

Scripting

 l Scene version description can now be queried and set using scene.Description and scene.setDescription from the 
Harmony scripting interface. The description can also be set when importing a scene through Control Center using 
ImportData.impDescription. The description text is limited to 200 UTF-8 characters. HAR-8792

 l The scene.closeSceneAndOpen JavaScript function has a new isReadOnly parameter which allows opening a 
scene in read-only mode. For example using scene.closeSceneAndOpen( "Env", "Job", "Scene01", "1", true); will 
close the current scene and open Scene01 in read-only mode. This can only be used when a scene is opened in 
Harmony from the database. HAR-9042

 l Added SceneOffline.createDatabasePartialUpdatePackage scripting function to create partial update packages for 
uploading to WebCC.  HAR-8875

 l The TB_MayaBatchRenderModule.js script has been modified to support renders using the 3Delight render plugin 
for Maya.  HAR-9148

Fixes

The following issues are fixed in this release of Harmony and later.

Camera

 l Small changes in the camera’s FOV don't have any effect and cause stutter when animating the FOV.  HAR-9005

 l The Tab key shortcut to move the transform tool pivot does not work.  HAR-8868

Drawing Workflow and Tools

 l Harmony crashes when closing a shape drawn with a textured pencil by holding the Ctrl key (command key on 
macOS) while Mirror View is enabled.  HAR-9011

 l Drawing with the Ellipse or Rectangle tool with snapping may draw on the wrong drawing layer.  HAR-8985

 l Harmony may crash when rotating a drawing using Ctrl+7 (command+7 on macOS) while the select tool is active.  
HAR-9118

 l Rare crash when using the Stroke tool.  HAR-9123
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 l Random crashes in the Pencil Editor tool.  HAR-9126

 l The Contour Editor creates loops when snapping adjacent vertices.  HAR-9131

 l Lines on unselected layers are difficult to see when the Light Table is enabled and the working colour space is set 
to Linear.  HAR-7446

 l Pasting a cut drawing object doesn't paste it at the proper location if there is an offset on the source or target 
drawing layer.  HAR-8854, HAR-9168

 l [Windows] Drawing Desk thumbnails display in low resolution on HiDPI monitors. HAR-8885

 l The Drawing view sometimes doesn't refresh when changing the selected drawing in the Drawing view Desk 
using the F and G shortcuts.  HAR-9073

 l The preference ‘Light Table: Shade in Camera View’ setting is not being saved.  HAR-9075

 l Drawings in the Reference View don't update when colours are changed using the Colour Picker.  HAR-9076

 l [Linux] The Colour Picker’s eyedropper tool always picks RGB values 0, 48, 57. HAR-8778

 l Zoom and rotate keyboard shortcuts can be used while drawing. HAR-9077

 l Shortcut to change to the Select tool does not work in the Reference View.  HAR-9094

 l The Drawing View Magnifier does not work properly.  HAR-9018

 l Deleting a drawing in the Drawing Substitution view which is also linked in a timing column in the Xsheet may 
cause a crash.  HAR-9224

 l Enabling Adjust Pencil Line Thickness in the drawing Layer Properties may cause artifacts on the pencil lines when 
rendering.  HAR-9250

 l Increasing the width and height divisions in the Envelope tool can cause a crash.  HAR-9264

 l Elements and drawings are duplicated when cutting and pasting element nodes in the Node View.  HAR-9078

Function Editor

 l Selecting multiple points on a 3D path in the Function editor with the marquee selection tool doesn't work.  HAR-
9103

 l The Function editor commits a random value to the selected keyframe when the Value field is empty and loses 
focus.  HAR-8830

General

 l Undoing after linking and reordering palettes may cause a crash.  HAR-7725

 l Duplicated drawings may be lost when saving a scene if synced layers have the same base name. HAR-8887

 l Copying multiple synced layers from one instance of a character to another may cause new drawings to go 
missing. HAR-8899
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 l The Transform tool bounding box is at the wrong position when using bitmap drawings with weighted or freeform 
deformers. HAR-7787

 l Harmony freezes when trying to read a TVG that has metadata.  HAR-8409

Import / Export

 l PSD files saved in Photoshop with compatibility mode disabled don't import correctly when imported using the 
Single Layer option.  HAR-8849

 l When importing a PSD layout image along with its XLI file, the XLI file from a previously imported image is used.  
HAR-9175

 l Harmony crashes when rendering to SGI 8-bit greyscale images.  HAR-9010

 l Renaming a palette does not flag the palette list as modified, causing the palette not to be saved.  HAR-9179

 l The Multi Layer Write node may cause adjacent drawing substitutions to composite in the same frame when 
exporting using Render Write Nodes.  HAR-8228

Nodes and Compositing

 l OGL-Controller node soft renders drawing from cable that is connected to the Controller Position port.  HAR-8877

 l The Deformation Composite node blocks transformation from upstream pegs.  HAR-9034

 l Harmony crashes when the OGL Controller has a label and the scale of the connected peg is set to 0.  HAR-9102

 l The Matte-Resize node can cause rendering to fail.  HAR-9163

 l The Blur effect on drawings connected to a Highlight or Tone node doesn't render correctly when intersecting with 
the camera edge if the Invert Matte option is enabled..  HAR-9181

 l The Auto-Patch node may cause a crash when rendering and changing frames if thumbnails are displayed in the 
Node View.  HAR-9255

Performance

 l Drag & drop of frames in the Timeline can be slow with some scenes.  HAR-8726

 l Operations that involve changing the current frame become slower with more Master Controller controls visible.  
HAR-8747

Rendering and Pipeline Integration

 l Harmony may crash with a memory corruption while rendering a scene in batch if a large number of rendering 
threads are used. HAR-7875

 l Small or simple drawings are sometimes missing from rendered frames when rendering using multiple threads on 
fast processors.  HAR-9012
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 l Alpha channel from movies rendered using ProRes 4444 or 4444 XQ is detected as straight by third party 
softwares.  HAR-7363

 l [Windows] Rendering to ProRes in Windows rounds down the horizontal resolution to the nearest multiple of 16 
pixels, cropping the rendered images.  HAR-9001

 l Exporting to SGI in 16 bits causes crash or colour corruption.  HAR-9008

 l Harmony may crash when batch rendering if palettes are located outside of the scene.  HAR-9023

 l Incorrect colours when the scene processing depth is 32-bit and the export format is set to 8-bit.  HAR-9047

 l Harmony may crash when displaying 3D models in the Perspective view if the OpenGL preference “Enable 
composite passthrough for all effects” is enabled.  HAR-9082

 l The Hold-Timing node causes OpenGL refresh issues and a possible crash.  HAR-9161

 l Selecting using the Shift key does not work well when scrolling the list of jobs in the Render Queue.  HAR-9117

 l Movies exported using 23.976 frame rate have their frame rate expressed as 2997/125 instead of 24000/1001.  
HAR-9109

 l When overwriting an existing movie file fails because it is opened or locked while batch rendering, Harmony will 
write the movie with a unique name using the date and time.  HAR-9133

Scripting

 l addNodeToSelectionNode, addNodesToSelectionNode and removeNodeFromSelection in the selection class do 
not work with backdrops correctly.  HAR-8391

 l Python's multiprocessing library is misconfigured when running on Windows.  HAR-8567

 l TB_RecolorDrawing.js will not work if a selected drawing node has no element ID.  HAR-9062

Timeline and Playback

 l Playback pauses momentarily at the end when Loop and Sound options are enabled.  HAR-8988

 l The F keyboard shortcut for 'Go to Previous Drawing' skips key exposures.  HAR-9019

 l When the 'Snap Keyframe' preference is enabled, copying and pasting a keyframe in the Timeline may cause a 
crash.  HAR-9199

UI

 l It's not possible to use the backspace key to remove the last digit in some fields such as those in the "Render Write 
Node" dialog.  HAR-9009

 l Typing decimal values in numerical input fields does not work when the OS is set to French.  HAR-9016

 l [Windows] Play does not work when there's a collapsed Camera view in the workspace.  HAR-9141
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 l [Windows] Uncollapsing a hidden camera view may cause a crash if a HiDPI monitor has scaling enabled.  HAR-
9142

 l [Linux] Focus On Mouse Enter doesn’t always work.  HAR-9095

 l Korean characters are not being typed in correctly.  HAR-9080

 l Harmony freezes if the Audo-save warning appears while doing a drag and drop operation.  HAR-9235

Database / Control Center

 l Copying a scene in Control Center does not work if the scene is not selected once the copy scene dialog opens. 
HAR-7888

 l [WebCC] Toast messages no longer appear once imports and exports are completed.  HAR-8884

 l WebCC stops responding to database requests if inactive for 48 hours.  HAR-9114

 l Baking of many scenes in WebCC results in error [Error: EMFILE: too many open files...].  HAR-9122

 l Control Center doesn't save the ‘Get rights to modify all assets' setting for environments.  HAR-9074

 l When 'Update Database Scene' fails the error reporting is uninformative and sometimes wrong.  HAR-8843

 l Locks can be taken on the root folder, preventing locks to any other folders in the database.  HAR-8556

 l Rendering through Control Center's scripting interface does not use the scene’s default camera if it is not specified 
by name.  HAR-8403

 l [Windows] WebCC does not start on a new Windows installation due to missing MSVCR120.dll in path. HAR-
8873

 l Using the ’‘Update Database Scene” command can corrupt the scene in the database if the scene was changed 
since it was exported offline. To address this issue, a new dictionary file named export.dict has been added to 
Harmony 21.0.4. The export.dict file will have to be manually copied to the  /USA_DB/dicts/ folder in existing 
Harmony databases. New databases created using Harmony 21.0.4 have the new dictionary file. HAR-8858

Xsheet

 l When the keyboard is set to french, pressing the ^ key in the Xsheet crashes Harmony.  HAR-9006

 l Rare and random crashes in Xsheet UI.  HAR-9125

Known Issues
 l When there’s not enough space to display all buttons in a toolbar, the extension that is opened to access the 

buttons will be hidden under views that use OpenGL.  HAR-8186

 l When using Harmony on macOS Big Sur, Harmony may crash when saving a colour in macOS’s native colour 
picker. HAR-8032

 l Database scenes that have a custom path cannot be copied using Control Center. HAR-6386
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 l Stroke remains in place after removing the last point of a branch with the centreline editor. HAR-5994

 l When using an iPad Pro in Sidecar mode with Harmony, every second click registers as a double-click.  HAR-8801

 l Updating the operating system to macOS Ventura may help fix this issue.

 l On macOS Mojave, GateKeeper prevents launching Harmony unless the quarantine extended attribute is removed 
from the application bundle. HAR-7775

The quarantine extended attribute can be removed using the following command in the Terminal:

$ sudo xattr -dr com.apple.quarantine "/Applications/Toon Boom Harmony 22 Premium"
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Harmony 22.0.1 Release Notes
Harmony 22.0.1 build 22.0.1.19338 (2023-03-01)

Fixes

The following issues are fixed in this release of Harmony and later.

Drawing Tools

 l Using the Close Gap tool while drawing with a tablet may cause a crash.  HAR-8828

 l The Paste Drawing Object in Place option doesn’t work when the focus is in the Timeline or Xsheet.  HAR-8606

Animation Tools

 l The Shift and Trace tool doesn’t display the drawing as it’s being repositioned.  HAR-8458

 l Peg holes and cross hairs for the previous drawing disappear after moving the drawing using the Shift and Trace 
tool.  HAR-8038

Timeline and Playback

 l Create Cycle messes up the layer’s timing and is not undoable.  HAR-3867

 l Frame Markers are not reversed when using the Paste Reverse command.  HAR-7385

 l A layer set to Outline Mode in the Timeline always displays black in the Camera view.  HAR-8573

 l [Windows] Playback can get stuck when Loop and Sound are enabled.  HAR-8808

Effects

 l A vector drawing connected to a Planer Region node that is defined to use Vector Drawing, connected to a Sprite 
Emitter may cause a crash.  HAR-8763

 l Certain shading effects may show inconsistent results between 16 bit and 32 bit renderings.  HAR-8721

 l Shine effect produces artifacts when alpha attributes are not set to default values and scene is set to render in 32 
bits.  HAR-8752

 l Bokeh effect shimmers when there is slow camera movement.  HAR-8803

 l Bokeh and blur effects render with artifacts when Enable Graphic Card Acceleration is enabled in the Preferences.  
HAR-8802

Camera

 l Show Snapshot in the Camera view doesn't display certain effects correctly. HAR-8735

 l The camera far clipping plane limit cannot be raised over 1000 units.  HAR-8805
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3D

 l 3D models and 2D layers disappear when rotating the Perspective view 90 degrees.  HAR-8758

Deformers

 l Minimum and Maximum Distance circles displayed for weighted deformers are not the proper size on a 
Retina/HiDPI displays.  HAR-8610

 l Minimum and Maximum Distance circles displayed for weighted deformers do not scale with the drawing.  HAR-
8609

 l Using the Transform tool with Control Selection Mode enabled does not work on a newly created deformation 
chain.  HAR-4650

Nodes and Node View

 l Crash when entering text in Node View search field.  HAR-8850

 l A Channel Swap node directly connected to a Display doesn't render correctly.  HAR-8728

 l Crash after enabling Publish Attribute Mode and the Drawing attribute in the Transformation Switch node.  HAR-
8848

 l Timing Columns options in the Transformation Switch node don’t work correctly.  HAR-7796

 l Rendering is incorrect when an art layer selector node is set to flatten and used in combination with the Animate 
Pencil Texture node.  HAR-8809

 l Reducing the alpha channel using a Matte-Resize node doesn’t work if the source image doesn’t have antialiasing.  
HAR-8582

Import / Export

 l Importing images from scanner locks up after previewing the images.  HAR-8818

 l PSD files from Adobe Photoshop 2021 and later are blank in Harmony.  HAR-8819

 l Images and 3D models disappear from the scene if the file name ends with a v and three digits (-v001).  HAR-7118

 l [Windows] Pasting an image copied from a web browser does not work.  HAR-8796

 l Precision loss and colour banding when writing 8 bit images in JPG, TGA, TIF and SGI if there is a colour space 
conversion.  HAR-8826

Scripting

 l Toon Boom Python API cannot be loaded unless a license with database is available.  HAR-8832

 l Add Python Interface Documentation to Help menu.  HAR-8769

 l A drawing created using Python script is not flagged as existing on the file system, and cannot be immediately 
loaded and rendered.  HAR-8856
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 l TB_ExportCamera script inverts the camera when some axes are rotated 180 degrees.  HAR-8647

 l [Linux] Plugins/Scripting packages are not loaded on startup.  HAR-8812

 l TB_GameExportWindow.js is not packaged in Harmony 22.  HAR-8811

 l Add a scripting method, setNumberOf to SCR_FrameInterface, which sets the scene length (moves the end red 
handle) without deleting the drawing or keyframe.  HAR-7358

 l Add missing functions to the ColorOverride class to add and remove colours. HAR-6671

 l Harmony crashes when rendering a 3d model via the python scripting interface.  HAR-8750

Performance

 l [macOS] Harmony sometimes crashes when waking from sleep mode.  HAR-8359

 l [macOS] When running in Japanese the Licence Wizard may crash when installing the licensing service.  HAR-
8694

 l The Save Scene Automatically preference does not work correctly when Harmony is left to idle.  HAR-6564

 l Top and Side views take a long time to refresh while thumbnails are being rendered.  HAR-8760

Devices

 l [Windows] Wacom tablet touch gestures for zoom, pan and rotate are not working.  HAR-8739

UI

 l [Windows] When sizing the Preferences window it may disappear offscreen if display scaling is not 100%.  HAR-
8566

Database / Control Center

 l The Update Database Scene error reporting is uninformative and sometimes wrong.  HAR-8843

 l Scene lock information is not displayed correctly in Control Center.  HAR-8049

 l [macOS] After closing a scene in database mode, Open, Palette Operations and other commands may stop 
responding.  HAR-8766

Rendering and Pipeline Integration

 l Palettes and palette lists are potentially locked during normal batch rendering.  HAR-8667

 l Harmony does not work with the LucidLink cloud NAS file system on macOS.  HAR-8806

 l Workstations that do not have a GPU may not have the OpenCL libraries installed and will fail loading the plugins 
for OpenCL effects such as Blur.  HAR-8693

 l Harmony is in "Not Responding" state for a long time before generating and uploading a snapshot preview from 
Producer.  HAR-8817

 l tbprocess/queue dependencies between rendering jobs are not correct. HAR-8816
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Other

 l Deleting a column in the Xsheet then undoing, may cause a crash.  HAR-8795

 l The Metadata Editor is not applying Scene Metadata values correctly.  HAR-8748

 l Scene takes 20 times more time to save on Windows than on macOS. HAR-9049

Known Issues
 l When there’s not enough space to display all buttons in a toolbar, the extension that is opened to access the 

buttons will be hidden under views that use OpenGL.  HAR-8186

 l When using Harmony on macOS Big Sur, Harmony may crash when saving a colour in macOS’s native colour 
picker. HAR-8032

 l Database scenes that have a custom path cannot be copied using Control Center. HAR-6386

 l Stroke remains in place after removing the last point of a branch with the centreline editor. HAR-5994

 l When using an iPad Pro in Sidecar mode with Harmony, every second click registers as a double-click.  HAR-8801

 l Updating the operating system to macOS Ventura may help fix this issue.

 l On macOS Mojave, GateKeeper prevents launching Harmony unless the quarantine extended attribute is removed 
from the application bundle. HAR-7775

The quarantine extended attribute can be removed using the following command in the Terminal:

$ sudo xattr -dr com.apple.quarantine "/Applications/Toon Boom Harmony 22 Premium"
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Harmony 22 Release Notes
Here is the list of changes in Harmony 22, build 22.0.0.18839 (2022-09-26):

New Features

Drawing Workflow

Feature Description

Updated Model view, now renamed 
Reference View

The Reference view (formerly known as the Model view) can now be used to 
import and display bitmap images that can be used as inspiration or as 
references while drawing.

Imported images are automatically saved in the scene's models folder. These 
reference images can then be loaded on demand in subsequent sessions using 
the Load Default References command.

The new Delete Current command has been added to the view to allow 
deleting images from the scene's models folder, without having to manually 
delete them using the file browser.

You can now import images and drawings into the Reference View using drag-
and-drop from a file browser or by pasting images from the clipboard.

Live Preview When Drawing with a 
Textured Pencil

The Pencil tool now displays the pencil texture as well as the thickness stencil 
assigned to the selected pencil preset as the line is being drawn, providing a live 
and accurate preview of the final line.

Paste in Place

A new command named Paste Drawing Object in Place is now available in the 
Edit menu. Unlike the Paste Drawing Object command, which pastes a copied 
drawing object with a slight offset, the new Paste Drawing Object in Place 
command always pastes the copied drawing object in the same position as the 
original. The new command can be accessed from the Edit menu and has the 
Ctrl+Shift+V (Command+Shift+V on macOS) shortcut assigned.

Frame Drawing Selection shortcut
A new shortcut command named Frame Drawing Selection has been added to 
Harmony. Using this command when a drawing tool is active will centre the 
Camera or Drawing view on the selected drawing. The default shortcut for this 
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Feature Description

command is Shift+F.

Rendering

Feature Description

32 Bits Per Channel Rendering Processing

Internal render operations in Harmony can now be performed using 32 bits per 
channel floating point values. This provides more precision and adds support for 
colour values below 0 and above 1 for high dynamic range rendering and colour 
accuracy. 

The bit depth used for internal processing can be changed between 16 bits or 
32 bits per channel from the Colour Space tab of the Scene Settings window. 

 

When 16 bits per channel is selected, scenes render as they did with previous 
versions of Harmony. When 32 bits per channel (float) is selected, all internal 
processing operations are performed with 32-bit floating point precision and 
does not clip colour values to 1. This allows Harmony to preserve colour values 
even when an effect raises the values of colours beyond white, which allows 
subsequent effects to recover those colours when lowering the values. 

New scenes created in Harmony 22 are set to use 32 bits per channel render 
processing by default. Scenes from previous versions are set to 16 bits per 
channel for backwards compatibility. 

Support for 32-bit floating-point EXR 
images

EXR Images saved with 32-bit floating-point colour depth containing values 
above 1 can now be read and their values preserved throughout the rendering 
process. 

Harmony now also has the ability to write EXR images in 32-bit floating-point 
colour depth. 

Displaying Colour Values

The Camera view status bar now displays the colour values of the pixel that is 
under the mouse when the Camera view is in Render View mode. Values are 
expressed as integers between 0 and 32767 when the scene is set to render in 
16-bit per channel and as float values when the scene is set to render in 32-bit 
per channel. 
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Feature Description

Effects and Compositing

Feature Description

Bokeh Blur Effect

The new Bokeh Blur effect in Harmony simulates how a camera lens blurs out-
of-focus elements based on the shape of its iris. 

 

To simulate depth of field, an alpha matte can be used with this effect to control 
the amount of blur applied to different areas of the image. Opaque areas in the 
alpha matte will fully apply the effect while transparent areas in the alpha 
matte will not apply the effect.  The Bokeh Blur node is available in the Node 
Library in the Filter > Blur category.

Animate Pencil Texture Effect

The new Animate Pencil Texture effect node works similarly to the Shake node 
but instead of shaking drawings or the camera in the scene, it applies random 
transformations to pencil line textures. This can be used to add life to drawings 
by simulating line boiling that occurs in hand-drawn animation where a new 
line is drawn for every frame.   

The Animate Pencil Texture node can automatically detect when there is a 
transformation or a drawing change from its input and apply the effect to the 
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Feature Description

texture. There is no need to manually time the effect and maintain the timing 
manually.

The Animate Pencil Texture node is available in the Filter category of the Node 
Library.   

Improved Blending modes

The blending modes available in the Blending and Composite-Generic nodes 
have been updated to support rendering in scenes set to use 32 bits per channel 
processing as well as provide closer results to blend modes from third party 
applications.  

The list of blending modes was simplified to remove beta and legacy blending 
modes. However, to provide backward compatibility, Blending and Composite-
Generic nodes in scenes from previous versions of Harmony will have the full 
list of legacy and beta blending modes. New instances of these nodes will only 
list the update list. 

Some blend modes require values higher than 1 to be clamped in order to 
provide the same result as third party softwares. However, clamping limits the 
use of those blend modes in the context of an HDR pipeline. A new Clamping 
Mode attribute has been introduced to the Blending and Composite-Generic 
nodes to control whether values should be clamped or not.

Improvements to the Colour Curve effect 
node

The Colour Curve node has been improved and extended to fully support scene 
set to render using 32 bits per channel processing.
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Feature Description

 l The new Clamp Output Values attribute can be used to control whether 
values should be clamped to the values specified in the Minimum and 
Maximum fields. This attribute is not available in 16 bit per channel 
processing. 

 l The new Extrapolate Curve Bounds attribute will extrapolate the curves 
beyond their first and last points. This attribute is not available in 16 bit 
per channel processing. 

 l A Zoom slider was added to allow zooming out the graph view and 
manipulate points beyond the 0 and 1 range. 

Animation

Feature Description

New Weighted Deformer Nodes

Four new weighted deformation nodes are now available in Harmony. These can 
be used to create different types of weighted deformation systems and 
individually control their influence on the overall deformation. Multiple types of 
weighted deformer nodes can be used in the same deformation system for more 
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Feature Description

flexibility. 

The following new nodes are available:  

 l Weighted Point: The Weighted Point node uses the pivot of each peg to 
create the deformation system. Add them to existing Weighted 
Deformer systems to apply different influence weights to individual 
groups of pegs.

 l  Weighted Curve: Used to define a curve that influences the deformation 
system. Three types of curves are available and are built using pegs 
connected to the node. 

 l Weighted Line: Creates a straight line defined by the attached pegs. The 
resulting line is used to influence the deformation. 

 l Weighted Drawing: Uses a single drawing as an input that is used to 
influence the deformation system. The drawing defines the shape of the 
influence and can be transformed with a peg in order to deform the 
overall system.  

The new weighted deformation nodes are available in the Node Library under 
the Deformation >Weighted category.

OGL Controller Node

The new OGL Controller node provides a pickable controller that can be used as 
a handle to select a drawing or a peg anywhere in the scene and that would be 
otherwise difficult to select. OGL Controllers are not visible in software renders 
and are only visible in OpenGL.  

The node provides basic shapes that can be used as the graphic representation 
of the handle. A drawing node can also be connected to use as a custom shaped 
handle. 

This new node is available in the Node Library under the Controller category.

Transform and Translate Tool Pivot 
Improvements

The following improvements were done to the graphical representation and 
manipulation of pivots when using the Translate and Transform tools: 

 l A new preference named Use a Donut-Style pivot in the Transform Tool, 
located on the Advanced tab in the Preferences, changes the circular 
pivot of the Transform to a donut, which allows selecting anchors 
located under the pivot through its central hole. This preference is 
disabled by default. 
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Feature Description

 l A new preference named Allow Temporary-Pivot dragging in camera 
view, located on the Advanced tab of the Preferences, disables the 
interactive manipulation of the Transform Tool pivot when unchecked. 
This preference is enabled by default. 

 l New shortcuts were added to move the position of the temporary 
Transform Tool pivot as well as the Translate tool pivot without having 
to click and grab it. 

 l Move Element or Peg Pivot to Cursor: Moves the selected 
Element or the Peg’s pivot to the mouse position while the 
Translate Tool is active. The Tab key is assigned as the default 
shortcut. 

 l Move Temporary Pivot to Cursor: Moves the Transform Tool’s 
temporary pivot to the mouse's current position in the camera 
view. The Tab key is assigned as the default shortcut. 

 l Move Temporary Pivot to Default: Resets the Transform Tool’s 
temporary pivot to its default position. Default shortcut: Ctrl+Tab 
on Windows and Option+Tab on macOS

Scripting

Feature Description

Python Scripting and Python Script 
Console

Harmony's Python Document Object Model provides a Python representation of 
Harmony and its loaded project. This allows for the creation of custom tools and 
automation tasks that can be run from within Harmony using the new Python 
Script Console, or externally to Harmony from a Python Interpreter.  

The Harmony Python module is compatible with Python 3.9 or later. If the 
module is imported from Harmony's Python Script Console view, Python 3.9.x is 
required.  

The Python Script Console will only be available when Harmony is launched in 
an environment that provides the Python libraries. The Python libraries path can 
be specified using the preference PYTHON_LIB_PATH or by making the python 
executable available from the PATH environment variable.

For more information please refer to the Main Page in the Python Interface 
documentation. The documentation is available by opening the index.html file in 
the Harmony application Documentation folder:

Windows: 

C:\Program Files (x86)\Toon Boom Animation\Toon Boom Harmony 22 
Premium\help\python\ 
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Feature Description

macOS: 

/Applications/Toon Boom Harmony 22 Premium/Harmony 22 
Premium.app/Contents/Documentation/python/ 

Updates to Qt Classes

Since updating to Qt 6 for Harmony 21.1 some Qt classes that were part of the 
QtScriptBinding packaged in previous versions of Harmony were either 
deprecated, replaced or were not included in Harmony 21.1.  

All the missing Qt classes are now packaged with Harmony 22. 

Fixes

General

 l Focus on Mouse Enter does not always work when the mouse is quickly moved to an OpenGL view. HAR-8218

 l Transform tool BBox is at the wrong position when using bitmap drawings with weighted and freeform deformers. 
HAR-7787

 l Transform tool BBox is at the wrong position when a Deformer is used with an Element node that has an offset. 
HAR-8464

 l Poor performance when a Channel-Swap node is used under a pass through composite. HAR-8340

 l OpenGL compositing order is wrong when an Apply-Peg-Transformationa node is used within a 3D scene. HAR-
8518

 l Vertex colours from alembic files are missing. HAR-8304

 l The preference Element Node “Animate Using Animation Tools” Default Value is ignored when importing a multi-
layer PSD. HAR-6845

 l High Discretizer Spacing values can cause the Envelope Creator to crash. HAR-7396

 l Lines are not Anti-aliased during playback. HAR-8262

 l Harmony may crash when opening a second scene if the node cache is active. HAR-8348

 l Disconnecting a cable from a Weighted Deform node sometimes disconnects the wrong cable. HAR-8535

 l Scan application crashes when attempting to import an image using the Load From File command. HAR-8350

 l H.264/MP4 is not available as an export format when running Harmony on an Apple Silicon system. HAR-8188
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Drawing

 l Thumbnails are not properly refreshed in the Drawing Substitutions view. HAR-7493

 l The Stroke tool's Draw Stroke as Straight Lines and Connect Line Ends options don’t work. HAR-8416

 l Vectors are not offset when pasting them multiple times to another art layer. HAR-8436

 l The drawing view does not refresh immediately when changing the Drawing Desk's shift and trace options. HAR-
8487

 l Tiny gaps at colour junctions after using the Stencil brush in Repaint mode. HAR-8417

Reference View

 l Layers cannot be dragged from the Timeline to Reference (Model) View. HAR-8323

 l Dragging and dropping a template from the Library to the Reference (Model) View does not work. HAR-8547

 l The Reference View uses the forward delete key rather than delete key to unload drawings. HAR-8539

Rendering

 l Turbulent Noise shifts when a blur effect is added below. HAR-7789

 l EXR images from “Multi Layer Write” nodes have multiple frames stacked on each other. HAR-8228

 l The Alignment Rule attribute has no effect in software renders with certain JPEG files. HAR-7335

Master Controllers

 l Master Controller rig state stops being parsed when a small or high value is met. HAR-8412

 l Adding or deleting rows and columns does not work from the Master Controller Grid Wizard. HAR-8564

Scripting

 l SCR_DrawingKey always returns null when a drawing key is provided in scripting. HAR-8407

 l Control Center’s scripting interface always renders the “Default” camera if no camera is specified. HAR-8403

 l QByteArray cannot be constructed with a string as its constructor's argument. HAR-8497

 l Invisible plus (+) and minus (-) buttons in TB_ExportToEaselJS, TB_ExportToSpriteSheets and TB_SelectionPreset. 
HAR-8500

Database

 l Link Server does not run on Linux if there is no X-Windows server. HAR-8563

 l Locks can be taken on the root folder, preventing locks to any other folders in the database. HAR-8556

 l Palettes are locked when batch rendering scenes if colours are recovered. HAR-8536

 l Importing scenes in batch mode crashes Control Center if the scene already exists. HAR-8503
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Known Issues
 l When there’s not enough room for all the buttons in a toolbar, the extension that can be opened to access the 

buttons is hidden when it opens over an OpenGL view. HAR-8186

 l Touch Gestures to zoom, pan and rotate don't work on Windows. HAR-8739

 l When using Harmony on Big Sur, Harmony may crash when saving a colour in macOS’s native colour picker. HAR-
8032

 l Database scenes that have a custom path cannot be copied using Control Center. HAR-6386

 l Stroke remains in place after removing the last point of a branch with the centreline editor. HAR-5994

 l On macOS Mojave, GateKeeper prevents launching Harmony unless the quarantine extended attribute is removed 
from the application bundle. The quarantine extended attribute can be removed using the following command in 
the Terminal:

$ sudo xattr -dr com.apple.quarantine "/Applications/Toon Boom Harmony 21.1 
Premium"
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